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How to update a WinCE5.0 program to WEC7.0

Platform Comparison

CPU PXA270 AM335x

Models WP-8x3x/WP-8x4x WP-8x2x/WP-9x2x
WP-514x/WP-515x WP-523x

VP-25Wx VP-x23x

OS Version WinCE 5.0 WinCE 7.0

Development Tools EVC/VS2005/VS2008 VS2008

Embedded SQL Server 3.5 3.5

.Net Compact Framework 35 3.5

Development Tool Requirements

Ensure that the necessary tools and the corresponding PAC SDKs are installed in your
computer. The table below provides a summary of the supported development tools and

languages required for developing PAC applications.

Language
Development Tool

Any version except
Visual Studio - -- -

Professional
2005 or earlier

Visual
Basic .Net

‘ Visual C++

‘ Visual C#

Professional -- -- --

Any version except

Visual Studio Professional -- -- -
2008
Professional v v v
Any version except
Visual Studio -- - -

Professional
2012 or later

Professional -- -- --

V: Supported, --: Unsupported
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Microsoftw
Visual Studio

Visual Studio 2008 Professional

Visual Studio takes full advantage of the .NET Compact Framework, which uses public
Internet standards to enable integration with new and existing applications running on

any platform. Supported languages include Visual C#, Visual C++ and Visual Basic .NET.

If you have an MISDN subscription, VS2008 Pro can be downloaded from

https://msdn.microsoft.com/en-us/subscriptions/securedownloads/hh442898 Otherwise,

you will need to purchase the software from your regular distributor.

Installation Procedure for VS2008

Step 1: Download the necessary installation files and updates

1. Visual Studio 2008 Professional

https://www.dreamspark.com/Product/Product.aspx?productid=1

2. Visual Studio 2008 Service Pack 1

http://www.microsoft.com/en-us/download/details.aspx?id=10986

3. Visual Studio 2008 update for Windows Embedded Compact 7

http://www.microsoft.com/en-us/download/confirmation.aspx?id=11935

4. Windows Embedded Compact 7 ATL Update for Visual Studio 2008 SP1

http://support.microsoft.com/kb/2468183/en-us
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Step 2: Install the platform development SDK package

The AM335x_WINCE7_SDK.mesi file contains the C header files, the C libraries and the

software development kit used to develop applications for the PAC series on the PC.

The SDK package can be found in the

CD:\wp-5231\SDK\PlatformSDK\ folder on the companion CD that was provided with

the package, or the latest version can be downloaded from the ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/sdk/platformsdk/

File name: AM335x_WINCE7_SDK_yyyymmdd.msi, where yyyymmdd is the released
date of the platform sdk.

Step 3: Execute the AM335x_WINCE7_SDK_YYYYMMDD.msi file

Step 4: Follow the prompts until the installation process is complete
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Upgrading EVC-based programs

Any existing EVC programs will need to be upgraded to VS2008 VC++ format in order to
run WP-9000 series.

To upgrade an existing EVC program, use VS2008 to create a new VC ++ project, follow
the procedure described below. The resulting code can then be applied to older EVC

programs.

To create a VC ++ program

Create a new project
Configure the platform
Specify the PAC SDK libraries

Add a control item to the form

LA I

Add the event handling for the control item
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Creating a new project

The Visual C++ project template is a composite control that is used in this example to

create a new project.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project to open the New Project

dialog

Edit View Tools Test Window Help

New » | 5] Project. Ctrl+Shift+N
Open » | & WebSite.. Shift+Alt+N
Close ‘3| File.. Ctrl+N
Close Solution Project From Existing Code...

Save Selected Items  Ctrl+S
Save Selected Items As...
Save All Ctrl+Shift+S
Export Template...

B £

Page Setup..
Print... Ctrl+P

o=

Recent Files 2

Recent Projects »
Exit
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Step 3: In the Project types pane, expand the Visual C++ node and then select Smart

Device

Step 4: In the list of Templates, select the MFC Smart Device Application item

Step 5: Specify a name and a location for the application, and then click OK

I._ B —————— m‘

— 'I—_ —— S - e

Project types: Templates: -NET Framework 3.5

New Project

Visual C++ Visual Studio installed templates
ATL SEJATL Smart Device Project #MFC Smart Device ActiveX Control
CLR {@MFC Smart Device Application si MFC Smart Device DLL
sﬂi’;ﬁral JElWin32 Smart Device Project
Smart Device My Templates
Test :Search Online Templates... i
Win32
Other Languages
Other Project Types i

Test Projects

An application for Windows Mobile and other Windows CE-based devices that uses the Microsoft Foundation Class Library

Name: SDK_Info
l Location: Ch\Users\Administrator\Documents\Visual Studio 2008\Projects hd Browse...
|| Solution Name: SDK Info [¥] Create directory for solution i
|
OK I I Cancel l
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Step 6: When the following windows appears, click Next

p
MFC Smart Device Application Wizard - SDK_Info

Welcome to the MFC Smart Device Application Wizard

Overview These are the current project settings:
® Windows Mobile 5.0 Pocket PC SDK Platform
# Single document interface

Platforms

Application Type
Click Finish from any window to accept the current settings.

Document Template Strings
User Interface Features After you create the project, see the project's readme. b file for information about the project features
and files that are generated.

Advanced Features

Generated Classes

|
{ <Pre\fi0L|s|E Mext = i[ Finish ” Cancel

Step 7: On the Platforms screen, select the platform to be added to the project,
AM335x_WINCE7_SDK and then click Next

p
MFC Smart Device Application Wizard - SDK_Info

=== platforms

Overview Select platform SDKs to be added to the current project.

Platforms

Application Type

Document Template Strings T Spres Selected SDKs:
User Interface Features Pocket PC 2003
Smartphone 2003
Windows Mobile 5.0 Pocket PC SDk
Generated Classes Windows Mobile 5.0 Smartphone S

AM335x_WINCE/_SDK

Advanced Features

1723

AM335x_WINCE7_SDK
Instruction sets: ARMv4I, ARMv4T

r <previous|[ Net> |[ Finish ][ cancel
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Step 8: On the Application Type screen, select the Dialog based option, and then click
Next

MFC Smart Device

Application Type

Overview Application type: Use of MFC:

Flatforms O single document (O Use MFC in a shared DLL

Application Type ® Dialog based ® Use MFC in a static library
Document Template Strings () Single document with DocList

User Interface Features

Document/View architecture support
Advanced Features

Resource language:
\@mx (=)

Generated Classes

<Previous || next> |[ Finish || cancel

e e G e

Step 9: Click Next on the User Interface Features screen

MFC Smart Device

lication Wizard - SDK_Inf

User Interface Features

Overview Command bar:

Platforms (% Menus only

Application Type () Menus and buttons
Document Template Strings

[] status bar

User Interface Features
Advanced Features Dialog title:

Generated Classes SDK_Info

<Previous” Mext = ][ Finish ” Cancel

T O S - T

Last Modified Date: Aug. 2016




Step 10: Click Next on the Advanced Features screen

MFC Smart Device lication Wizard - SDK_Inf

_—
Advanced Features

Overview Advanced features:
Platforms U windows Help
Application Type [ printing and print preview

Document Template Strings O Y

User Interface Features B windows sockets

Number of files on recent file list:

Advanced Features
t Generated Classes

r [<Previuus][ Next > ” Finish J[ Cancel J

Step 11: Click Finish on the Generated Classed screen

MFC Smart Device lication Wizard - SDK_Infe
_—
Generated Classes
Overview Generated classes:
Flatforms
CSDK_InfoDlg
Application Type
Document Template Strings
User Interface Features s nEe h file:
l ackancedlEsatiies CSDK_InfoApp [spk_info.h |
Generated Classes
Base class: .cpo file:
CWinApp |SDK_Inf0.cpp |
|
|| - —
[< Prewous][ Next > H Finish J[ Cancel J
[ B e e W | —
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Configuring the Platform

When developing applications using Visual C++, the Platform must be configured to
indicate which platform and device the application will be downloaded to. Before

deploying the project, ensure that the platform is corrected.

On the Debug configuration toolbar, select the Release option and then select

AM335x_WINCE7_SDK(ARMvA4I), as illustrated below.

~ N

A RAERA=A" B IR A A v;;:lv;;'l,.(b Release v AM335x WINCE7_S v |

~N -

L

5
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Specifying the PAC SDK Libraries

The PACSDK libraries for WP-9000-CE7 series module are provided in the PACSDK, and are
compatible with C++. In order to use a component in an VC application, It is must to link
PACSDK.lib in the project first.

Step 1: On the View menu, click the Property Pages option

File Edit Project Build Debug Tools Test Window Help

=3 | Solution Explorer Ctrl+Alt+L
) | Bookmark Window Ctrl+K, Ctrl+W
5% | Class View Ctrl+Shift+C
_ & Code Definition Window  Ctrl+Shift+V
=9 | Object Browser Ctrl+Alt+)
=] | Output Alt+2
E‘% Property Manager
4| | Resource View Ctrl+Shift+E
%+ | Toolbox Ctrl+Alt+X
Find Results >
Other Windows >
Toolbars »
&l | Full Screen Shift+Alt+Enter
&1| Navigate Backward Ctrl+-
(=} | Navigate Forward Ctrl+Shift+-
Next Task
Previous Task
Property Pages
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Step 2: In left pane of the Property Pages dialog, expand the Linker node, and then click
Input

Step 3: In the right pane of the Property Pages dialog, enter PACSDK.lib in the

Additional Dependencies item

SDK_Info Property Pages n-‘ " n 2 » a0 44 M
Configuration: lActive(Debug) V] Platform: lActive(AM335x_WINCE?_SDK G '] l Configuration Manager... ] '
Common Properties Additional Dependencies PACSDK.Iib (]
Configuration Properti Ignore All Default Libraries No
General Ignore Specific Library
Debugging Module Definition File
Deployment Add Module to Assembly
C/C++ Embed Managed Resource File
I Linker Force Symbol References
General Delay Loaded DLLs
I"qu . Assembly Link Resource
Manifest File
Debugging
System |
Optimization
Embedded IDL
Advanced
Command Line
Resources

XML Document Gen
| Browse Information
Build Events
Custom Build Step
Authenticode Signir

Additional Dependencies

Specifies additional items to add to the link line (ex: kernel32.lib); configuration specific.
4 11 >

F Lok ] [Lconcel ] [ 2pply

Step 4: Click the OK button to exit the Property Pages dialog
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Adding a control to the form

A variety of controls can be dragged from the Toolbox and placed onto the form. These
controls, however, are not really "live"; they are simply images that can be used as a

convenient method of moving an object to a precise location on the form.

After adding a control to the form, use the Properties dialog to set the parameter values
for the control, such as the background color and the default text, etc. The values that are
specified in the Properties dialog are the initial values that will be assigned to that

property when the control is created at run time.

Step 1: On the View menu, click the Resource View option

File Edit | View | Project Build Debug Tools Test Window Help

[z] | Code Ctrl+Alt+0
=3 | Solution Explorer Ctrl+Alt+L
) | Bookmark Window Ctrl+K, Ctrl+W
5% | Class View Ctrl+Shift+C
_ & | Code Definition Window  Ctrl+Shift+V
=4 Object Browser Ctrl+Alt+)
=] | Output Alt+2
E Property Manager
‘4 Resource View Ctrl+Shift+E
%+ | Toolbox Ctrl+Alt+X
Find Results »
Other Windows b
Toolbars »
& | Full Screen Shift+Alt+Enter
&1 | Navigate Backward Ctrl+-
[} | Navigate Forward Ctrl+Shift+-
Next Task
Previous Task
Property Pages
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Step 2: In the Resource View Panel, expand the [Project name].rc file node, expand the

Dialog node, and then click the plug-in dialog item

‘Resource View - SDKInfo w L X |
=-izd SDK_Info
=-Ea SDE Infourc
=1 Dialog
I®:-110D_SDK_INFO_DIALOG
Ei Icon
&£ Version

-

~SDK_nfo.rc - IDD_S... - Dialog| v X
LI...I....I....I....I....d
I 1 sDK Info =)
=
1 TODO: Place dialog oontrols here, "
« | T | 3 E
[@Resource... [3: Toolbox [ 2 Property .| |-
Step 3: Drag a Button control from the Toolbox panel onto the form
H Dialog Editor -
k Pointer ﬂ
||:| Button
x| Check Box N
abl Edit Control i \/
~SDKUnfo.rc - IDD_S... - Dialog| v X

Combo Box

EH List Box vl

||||d

[ Group Box T

& Radio Button =

|| SDK _Info [=]

An Static Text

Picture Contral
E Horizontal Scroll Bar - "
B Vertical Scroll Bar - 4
4= Slider Control

3uToolbox [ 2 Propi| | -

: | |

TODO: Place dialog controls here,

L.,
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Step 4: On the Properties panel, type Check the SDK version in the Caption field

Properties « 1 X
IDC_BUTTONI (Button Control) ICeButtonEc -
RN EIFAl=

E Appearance

Caption Check the SDK version
Client Edge False
Horizontal Alignmer Default
Modal Frame False
Multiline False
Notify False
Static Edge False
Vertical Alignment Default
B Behavior
Default Button False
Disabled False
Owner Draw False
Visible True
E Misc
(Name) IDC_BUTTOM1 (Button C

rou WWW

Step 5: In the Properties window, type Check the SDK version, and press ENTER to set

the Text property

IDC_BUTTON1 (Button Control) ICeButtonEditor ~

[E Appearance

Chock e SDK versin
Client Ed ge False =
Horizontal Alignment Default =
Modal Frame False
Multiline False
Notify False
T “
Caption

Specifies the text displayed by the control.

rRes:Jurce View ]@Soluﬁon Explorer l gProperties '
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Adding the event handling for the control

Once the design stage for the application is complete, code can be added to provide the

functionality for the program.

Step 1: Double-click the button on the form

@] SDK_Info (=]

™y

| u |
s Checkthe SDE vession  |m
| [ ] |

TODO: Flace dialog controls here,

Step 2: Insert the following code

char sdk_version[32];

TCHAR buf[32];
pac_GetSDKVersion(sdk_version);
pac_AnsiToWideString(sdk_version, buf);
MessageBox(buf,0,MB_OK);

T Y i VA e i A VW

Hwvoid CSDE Infallg::0nBaClickedButtonl()
{

\J

HfTODO: Add wour control notification handler code here
char sdk_wersion[32];

TCHAR buf[32];

pac_OGetSDEVersion(sdk version);

pac_dnsiTolideString{sdk _version,buf);
MessapgeBox (buf ,0 ,MB 0K ;

\u_m\...pf \w‘ J v

}
TN TN mwﬂ\rw’
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Step 3: Insert the following code into the header section

ttinclude “PACSDK.h”

H

#include
#include
#include
#include
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{
"stdafx.L"
"SDE_ Info.h" (;
"SDE TnfoDlg .h" J
"PACSDE 1" IE;

B#i1fdef _DEBUG
J’JMWWWJN




CH#, VB.net Upgrade

Converting existing projects developed using VS2005 to VS2008.
Step 1: Open an existing VS2005 project using Visual Studio 2008

"2

Step 2: The Conversion Wizard will automatically convert a VS2005 project to a VS2008

project

The following is an example of how to convert a C# project that was developed
using VS2005, 8k_di.sIn to VS2008 C# project.

1. Open VS2008, click the file directory and select the VS2005 project,8k_di.sIn

|

.
.:‘D

» v >
ER View Poect Taget Tode Tet Wndow Hel Py
- il A B E-3 e B -l B -7

3 ¢
. ‘vf:«:v_cvycnli' 5 ﬁ
o Visual Studio 2008 I
r—— 2l
- v )« mm » &_a f_‘- - ngif;_a;‘ R }

chme v New folder 7 =~ B ® .
3. Recent Places 4 Neme : Date modihed
- 201676720 0
S Uvies : Qc_d m 20 L F q
* Documerts \H ek W12/10724 FF 0
Openc & M ) |

J e Pictures
e
Whatinewny ™ Comoue
Sarples y‘-ﬂ\*J ﬁﬁm‘ )

i
3
{
>
\)
rd
Use & Starter K Ca Sean_2ndHD_D (0:) }
™~
£
~
N
5
g
-
2
h
5

m

New Progect Fif a Sean_2nMD_E (E) =
HowDol..? o Sean_2ndHD_F )

= Removable Ditk (G:) -
— 3 id €D Drive (K] ASUS USB Dirver ——
Ok G Product Fies (NIO110739)0) _ , - . ; o

| Show outpu from. Fld. o aranssonan et -
1 File name: 8k _di | All Project Files (sin;? dsw;*ve |

‘ l Open H[ Cancel ]
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2. Once the Conversion Wizard screen is displayed, click the Next button

Welcome to the Visual Studio
Conversion Wizard

The golution ar project you are opening wag created in a previous
verzion of Yisual Studio. [t must be converted to the format used by
thiz verzsion. After a golution or any of itz projects haz been
corwerted, it may no longer be possible to edit, build, or run in
previoLs wersions.

If the solution or project iz under source contral, it will be checked out

automatically during the conversion. Be sure the corect Source

Contral Plug-in is actiee, and no files are exclusively checked out by
other uzers.

Click Mext to proceed.

3. Once the Backup options screen is displayed, click the Next button

Visual Studio Conversion Wizard :
Choose Whether To Create a Backup

If pou want a copy of pour solution or project inits current format, it must be backed up.

C:\emphittemphk_dit ﬁ rowse
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4. Once the Ready to Convert screen is displayed, click the Finish button to

complete the conversion.

Vizual Studio Conversion Wizard

ﬁ Ready to Comvert
E Review the following summary information. Click Finish to convert your golution or

project.
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Existing projects developed using V$2008

Any projects developed using VS2008 do not need to be converted or re-built.

Warning & Tips

The WCE7 operating system only supports .NET Compact Framework Version 3.5.
A There is no guarantee that applications using .NET Compact Framework Version
2.0 will run normally. If problems are encountered, it is recommended that the

project is rebuilt for NET Compact Framework Version 3.5.
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